
1 

 

General map notes: 

The sample points may not line up with the chosen basemap. The points are aligned with the NHD Plus version 2 NHDFlowline streams. 
Actual field sample locations may differ slightly depending on the ground situation and personnel collecting the samples.  

Overview 

There are tabs available along the left under the map name and tools available in the upper left-hand corner of the map under the 
search bar.  Navigating the Map 

Legend Tab | Resources | Sample Site Maps | Add Layer from ArcGIS Online, a URL, or a File | Change Base Map 

Filter Points | Select Points by circle, rectangle, or polygon | Geoprocessing - download points by area of interest |  Search Bar 
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The attribute table is available by selecting the arrow at the bottom of the map. You can filter by HUC or other 
attributes. Note that the Filter Points button also allows you to specifically filter by HUC name or bull trout presence/
absence. 

Occasionally the arrow will not 
be available even after refreshing 
your browser. You can open the 
attribute table by opening the 
Select tool to select points and 
using the ellipsis to select "View 
in Attribute Table."

http://www.fs.fed.us/rmrs/people/sparkes
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Navigating the Map – general tips 

To zoom in and out, use the + or – buttons in the upper-left hand corner of the map  or use the scroll on your mouse. 

To immediately zoom out to the initial extent, click the “home” button in the upper-left hand corner of the map 

To see the attributes of specific points on the map, use your mouse to click that point. A box will pop up with those available 
attributes. If more than one point is selected, or there are line data under the point, you can use the navigation to see the next 
attribute. 

 

 Legend Tab (ESRI help document for this tool)

The Legend tab loads with the map as a default. It shows the visible map layers and their symbols. To minimize this 
(or any) tab, click the arrow in the bottom right section of the tab. 

eDNA Field Collection Sites – Points represent the sample site locations. Colors help users find those points that 
were sampled and where bull trout was absent (green triangle with an X;, points that were sampled and where bull trout 
were present (blue circle), points that are being processed (black square) and those point locations that are not yet 
sampled (gray diamond).  If you would like to participate, the gray diamond sites would be ideal. Visible at all scales, but 
symbology changes as you zoom in past 1:555,000 (scale bar at 3 miles). Note that previous versions displayed a green circle 
with an X for sample results with bull trout absent. This was modified to a green triangle while the blue circle indicating samples 
where bull trout eDNA was present were made slightly larger. This allows users to see multiple samples at the same location. 
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_eDNAFieldCollectionSites_21/MapServer     

Climate Shield Patches – Light blue stream lines from the Cold Water Climate Shield project that denote streams at 
less than 11° C and a bull trout probability of greater than 10%. This layer is visible only as you zoom in beyond 
1:500,000 (scale bar at 3 miles) and has a slight transparency. 
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_eDNA_ClimateShieldPatches_01/MapServer 

USFWS Bull Trout Spawning and Rearing Critical Habitat – thicker light orange stream lines from the US 
Fish and Wildlife service as queried "H_USE_TYPE" = 'SR'. This layer is visible only as you zoom in beyond 1:500,000 
(scale bar at 3 miles). 
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_eDNADistributionSR_01/MapServer  

Navigate to the next 
point or line attribute 

Close the attribute 
window 

Pan to, Add a Marker, or 
View in Attribute Table 

Zoom in to the 
selected point 

http://doc.arcgis.com/en/arcgis-online/get-started/view-legend.htm
https://www.fs.usda.gov/rm/boise/AWAE/projects/BullTrout_eDNA/Participating.html
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_eDNAFieldCollectionSites_21/MapServer
https://www.fs.usda.gov/rm/boise/AWAE/projects/ClimateShield.html
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_eDNA_ClimateShieldPatches_01/MapServer
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_eDNADistributionSR_01/MapServer
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Bull Trout Distribution Watersheds – Polygons noting the watersheds for bull trout distribution from the WDB. 
The layer is always visible, but watershed names (HUC8_NAME) are shown between 1:3,500,000 & 1:1,150,000. 
https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_eDNAWatersheds_01/MapServer 

Resources 

The Resources tab contains links to the Range-wide bull trout eDNA project website, including supporting 
science. Click this button to see those resources and links. 

 Sample Site Maps 

The Site Maps tab contains links to the Range-wide bull trout eDNA project static PDF maps and Excel 
spreadsheets by HUC 8 watershed. Click this button to see an example map and the link to the page containing 

those digital static maps and sample coordinates in excel spreadsheets. 

 Citation 

The citation if using the downloaded data or data in the map. This panel also includes a link to the Research Data 
Archive DOI, which includes very detailed GIS metadata. The citation is also at the end of this guide 

 More Panels 

Choose this option to change your basemap or add a relevant data layer to this map. 

Click to minimize the 
Legend or any tab 

https://apps.fs.usda.gov/fsgisx02/rest/services/rmrs/RMRSAWAE_eDNAWatersheds_01/MapServer
https://www.fs.usda.gov/rm/boise/AWAE/projects/BullTrout_eDNA.html
https://www.fs.fed.us/rm/boise/AWAE/projects/BullTrout_eDNA/SampleSites.html
https://www.fs.fed.us/rm/boise/AWAE/projects/BullTrout_eDNA/SampleSites.html
https://doi.org/10.2737/RDS-2017-0038
https://doi.org/10.2737/RDS-2017-0038
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Change Base Map  (ESRI help document for this tool) 

Clicking the Basemap Gallery button allows you to 
choose a different base map or background layer. This 
may be helpful as you zoom into your specific area of 
interest. 

Add Data Layer from a URL or ArcGIS Online 

Choosing the Add Data Layer button allows you to add other online layers to this map. You can 1) search the available data in 
ArcGIS online, or 2) enter a specific URL if you already have a web service link or a KML file, GeoRSS File or CSV file URL, or 
3) upload a file from your computer. It supports shapefiles in Zip format, and CSV, GPX and GeoJSON files.

Click the icon to only search layers 
within the map area. Clicking it turns the 
icon red so you can search all layers in the 
scope.  
Click the sort icon to refine the type of 
search layer and sort the items.  

• Click the Type drop-down list to
search layers based on map service,
feature service, image service, vector
tile service, KML, or WMS.

• Click the Sort By drop-down list to
sort items by relevance, title, owner,
rating, view, or date.

http://doc.arcgis.com/en/arcgis-online/create-maps/choose-scene-basemap.htm


5 
 

 
 
 
 

 
 
To remove layers added click LAYERS in the lower right corner of the Add Data window. In the Layers panel, click 
the trash can icon next to the layer to remove it. 
 
Click BACK in the lower right corner to return to the main Add Data panel. 

Note that you can’t remove the added layer without refreshing the map, but you can turn that layer off in the Layer List tab. 

 

Click the File tab to upload files locally. 
You can either drag and drop the file 
or browse to it. It supports shapefiles 
in Zip format, and CSV, KML, GPX 
and GeoJSON files. 

To add layers by URL, click the URL 
tab next to the Search tab. Choose a 
type and enter the URL. Click Add to 
add the data to the map. The added 
layer will appear in the Layer List 
widget as well. The following types are 
supported through the URL: 

• ArcGIS Server web service 
• WMS OGC web service 
• KML 
• GeoRSS 
• CSV 
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Filter Points 

The Filter Points button allows you to filter the points on the map and in the attribute table by bull trout sample 
results and/or HUC8 watershed boundary. 

After clicking the button, use the drop-down boxes to make your choice(s). You can filter by one of these or by both. 

Once you’ve chosen how you want to filter, click the green toggle button to apply that filter. 

To remove the filter, toggle the apply button off. It will turn from green/on to gray/off. 

You can build custom filters using the Options in the attribute table. See example. 

Select Points (ESRI help document for this tool) 

Clicking this button and using the Select Points tool allows you to choose up to 1000 points on the map by 
rectangle, polygon, or circle. You can use it in conjunction with the Filter tool or you can zoom in and select points in a 
general area. You can view the selected points in the attribute table, and even export to a CSV file from there.  

Please note that this selection tool doesn’t allow export to a shapefile. It also does not allow for you to select more than one 
area. For those options, please see the Geoprocessing Tool to Extract Points by Area of Interest. 

Filter on 

Click drop-down 
arrow for HUC 
Names. You can 
search or scroll 

Build custom 
filters 

https://doc.arcgis.com/en/web-appbuilder/create-apps/widget-select.htm#ESRI_SECTION1_037E2A1D92164041AA5158D86F287FAA
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Select by Rectangle and Select by Circle draw those shapes for you. Select by Polygon requires that you draw your polygon 
boundary and you will need to click the map to start that polygon. 
 
You can clear your selection by clicking the “Clear” button in the upper right-hand corner of the Select window. If you have 
already closed the window, you can click the Select button again to open the window and clear the selection. 
 
After a moment, the points are selected. Once they are available, click the ellipsis (…) to see your options.  

 
 
You can view only the selected points in the attribute table by clicking the arrow at the bottom of the map to open the 
attribute table and choosing Options/Show Selected Records. 
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If you choose to view in the attribute table, you can export selected points to a CSV file for download. Note that the 
downloaded CSV file contains all the attributes for each point and not the small amount available in the AGOL map. 
 

 
 

 
 Geoprocessing - Extract and Download Points by Area of Interest (ESRI help document for this tool)  
 

Clicking the Geoprocessing button brings up a tool that allows you to select an area of interest. Once you’ve made your 
selection, you can export the points within the area(s) of interest as a shapefile or geodatabase. Please note you will only be 
exporting the eDNA site locations. If you would like to download Climate Shield data, you can do that here - 
https://www.fs.fed.us/rm/boise/AWAE/projects/ClimateShield.html 
 
Notes: 

• You can create more than one polygon to select different areas.  
• If using a triangle, circle, or oval, the area you click and drag will be in the center of the drawn triangle, circle, or oval. 
• If using a square or rectangle, the area you click and drag will be one side of the square or rectangle. 
• This tool does not select points. Rather, it allows the points within your area(s) of interest to be exported to a 

shapefile. To select points to view in the attribute table, use the Select Point tool. 
 

Once you’ve selected your area(s), click the “Run” button. Depending on the size of your browser window, you may need to 
scroll down to see the button. After a few moments, the Output tab will be a link to an output zip file containing a shapefile or 
geodatabase with your selected features. This shapefile includes the metadata in an XML file. Please note that the points in the 
map may need to be projected to match the data for your project. 
 

http://doc.arcgis.com/en/web-appbuilder/create-apps/widget-geoprocessing.htm#ESRI_SECTION1_F13A2550845D46CF812375675132DAD6
https://www.fs.usda.gov/rm/boise/AWAE/projects/ClimateShield.html
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To remove the polygons you’ve created, click the ‘delete’ red exclamation icon. 

Search Bar  

Search for a stream by NHD Plus version 2 GNIS_NAME. Type your search and hit ‘enter’ or click the magnifying glass. 

Square and rectangle: 
Start drawing at the 
corner 

Polygon and 
freehand: Click to 
start, then click to 
continue. Don’t drag. 

Oval and 
circle: Start 
drawing in 
the middle 



10 

Searches take a moment and return up to 50 results. You can use this tool if you are not certain geographically where a stream 
or watershed is located. It will automatically zoom to the first result, but the search bar will have a slider to search for other 
results. Click another result and the map will zoom or pan to that location. 

Tip:  If you filter the available points to a specific HUC, the search results will be only those GNIS names within that specific 
HUC. Alternatively, turn off the filter before searching outside the filtered HUC. 

Attribute Table  

The attribute tables can be opened and closed by clicking the arrow located at the bottom of the map. There are 4 tables 
available.  
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eDNA Field Collection Sites | Climate Shield Natal Habitat Patches |  
USFWS Spawning and Rearing Critical Habitat | Bull Trout Distribution Watersheds 

 
For any of these attribute tables, you can choose the Options link in the upper left-hand corner of the table to create a filter or 
to show different columns. As you zoom in on the map, the default is to filter the attribute table based on what is in the map 
view. Click that option to turn it off. You can filter and select point(s) and then zoom to that location. 
 

 
 

 
 
 
The eDNA Field Collection Sites point attribute table shows the following attributes: 

 
 

Location Attributes 
FID Unique ID internal to shapefiles 
Shape ESRI generated; internal to shapefiles 

eDNA_ID Full eDNA Project ID number for the sample point derived from concatenating the 
HUC8 number and the unique eDNA sample Site_ID. 

HUC8 Watershed Boundary Dataset 8-digit subbasin number 
HUC8_Name Watershed Boundary Dataset 8-digit subbasin name 

Site_ID eDNA Field sample point unique ID. This is a TEXT field and may need to be 
formatted in your CSV or Excel spreadsheet.  

COMID Common identifier (COMID) of the underlying NHDFlowline (version 2)  

GNIS_NAME Feature Name from the Geographic Names Information System (GNIS_NAME) 
NHD Plus version 2 

REACHCODE REACHCODE of the underlying NHD Plus version 2 NHDFlowline 

TotDASqKM Total Upstream Cumulative Drainage Area, in square kilometers, at the downstream 
end of the NHDFlowline 

SummerQ Mean summer flow (cfs) at the sample point from the VIC flow model  

eDNA_Slope Stream channel slope averaged to the next upstream field sample point or tributary. 

Land Owner (Ownership) - Land ownership at the field sample point from the Protected Areas 
Database of the United States 

Date_Coll Indicates the date the eDNA sample was collected. Null = Not sampled or date 
unknown. 

Datasource Agency or organization of the individual who collected the field sample. 

ID_Tag Unique ID assigned to each eDNA sample stored/processed at the National 
Genomics Center for Wildlife and Fish Conservation 

BT_Present 
Indicates if a site has had eDNA sampled and if bull trout is present.  [Value = 1 (not 
sampled); Value = 2 (sampled, bull trout absent); Value = 3 (sampled, bull trout 
present); Value = 4 (sampled, being processed)] 

S1_93_11 Mean August NorWeST Stream Temperature (C) at the sample point 

Detailed metadata here 

https://www.fs.usda.gov/rm/boise/AWAE/projects/modeled_stream_flow_metrics.shtml
https://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST.html
https://doi.org/10.2737/RDS-2017-0038
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bull trout presence Pop-up text corresponding to the BT_Present field 

Point Coordinate Attributes 
DD_X Grid coordinate - x-coordinate in Decimal Degrees 
DD_Y Grid coordinate - y-coordinate in Decimal Degrees 
UTM_Zone Grid -UTM Zone based on eDNA point file (NAD 83) 
UTM_X Grid Coordinate - UTM x-coordinate generated from point file 
UTM_Y Grid Coordinate - UTM y-coordinate generated from point file 
Field_Zone UTM zone for the coordinates where the sample was collected in the field. 
Field_East UTM easting (X) coordinate where the sample was collected in the field. 
Field_Nrth UTM northing (Y) coordinate where the sample was collected in the field. 

Field_Lat Sample point y-coordinate in Decimal Degrees where the sample was collected in the field. 
Contributor field coordinates. 

Field_Lon Sample point x-coordinate in Decimal Degrees where the sample was collected in the field. 
Contributor field coordinates. 

x ESRI generated x coordinate when downloading from ArcGIS Online 
y ESRI generated y coordinate when downloading from ArcGIS Online 

 
The default table view is to filter the attribute table based on what is in the map view. For example, if you are not seeing Bull 
Trout Distribution Watershed attributes, zoom in to turn on the layer.  You could also toggle off the “Filter by map extent” 
option on the table view. Depending on how many records there are in your view, it may take several moments to populate 
the table. 

 
 
The Climate Shield Natal Habitat Patches line attribute table shows the following attributes: 
 

NORWEST – NorWeST Production Unit name 
 
PATCH_ID – Climate Shield Patch ID 
 
BT_0BRK - probability of bull trout occurring somewhere within a patch assuming brook trout occur in none of the sites within 
that patch 

 
The USFWS Spawning and Rearing Critical Habitat ["H_USE_TYPE" = 'SR'] line attribute table shows the following attributes: 
 

BTID - Unique identifier for critical habitat - Originally was LLID value from StreamNet PNW Hydro data set (streams) or 
generated by USFWS (marine). 
 
RecoveryUn - Bull Trout Recovery Unit 
 
CHU_NUM - Critical Habitat Unit number 
 
CHU - Name of Critical Habitat Unit 
 
OCCUPANCY - Known status of Bull Trout occupancy [O = Known occupied; P = Presumed occupied; U = Unknown occupied] 
 

 
The Bull Trout Distribution Watersheds polygon attribute table shows the following attributes: 
 
 HUC_8 – Watershed Boundary Dataset HUC 8 number 

http://www.fs.usda.gov/rm/boise/AWAE/projects/NorWeST.html
http://www.fs.usda.gov/rm/boise/AWAE/projects/ClimateShield.html
https://www.fws.gov/pacific/bulltrout/Habitat.cfm
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 HUC_NAME – Watershed Boundary Dataset HUC 8 Name 
 
Filter Attribute Table by HUC example   
 
Click on the arrow at the bottom of the map to open the attribute table 
 
Click the Options tab in the upper left-hand corner of the table and choose the Filter option 

 
 

In the Filter window, click “Add a filter expression” and then use the dropdown to choose HUC8_Name (String). Click the 
Unique radio button.  

 
After a moment, click the dropdown. It will be populated with the available HUC8 watershed names. Choose your desired 
watershed and click “OK”. 
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Both the map and the attribute table will show only the points within that watershed. You can click to the left of the first 
record in the table, move the slider bar along the right all the way to the bottom of the filtered attributes, and then click the 
shift key and select the last record. This will select all the points you have filtered. 
 
Note that your mouse will change from an arrow to a pointing hand when selecting. 
 

 
Once you have selected all the points you wish to export, Click the Options tab in the upper left-hand corner of the table and 
choose the Export Selected to CSV option. 
 
 

 
You will be prompted to confirm that you want to export to a CSV file. Click OK. 
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You then have the option to Open or Save the file. Click OK. 

Please note that there is no automatic download of the metadata with the table as there is when you download using the area 
of interest geoprocessing tool and export as a shapefile. You can find a general metadata document on the bull trout eDNA 
website to add to any downloaded CSV files. 

To remove the filter, click the X to the right of the filter expression 

Please cite downloaded data as: 

 Young, Michael K.; Isaak, Daniel J.; McKelvey, Kevin S.; Schwartz, Michael K.; Carim, Kellie J.; Fredenberg, W.; Wilcox, 
Taylor M.; Franklin, T.; Chandler, Gwynne L.; Nagel, David E.; Parkes-Payne, Sharon L.; Horan, Dona L.; Wollrab, Sherry P. 
2017. Species occurrence data from the Range-Wide Bull Trout eDNA Project. Fort Collins, CO: Forest Service Research 
Data Archive. Updated 05 June 2021. https://doi.org/10.2737/RDS-2017-0038. 

Link to ArcGIS Online Map

https://www.fs.usda.gov/rm/boise/AWAE/projects/BullTrout_eDNA/downloads/bull-trout-eDNA-extracted-points-metadata.pdf
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